Elecard Video Quality Estimator v.4.2
User Guide
CONTENTS

1. INTRODUCTION ........................................................................................................... 4
  1.1. PREFACE .................................................................................................................. 4
  1.2. DESCRIBING ELECARD VIDEO QUALITY ESTIMATOR ........................................ 4
    1.2.1. Supported Video Formats ................................................................................... 4
    1.2.2. Supported Raw Formats .................................................................................... 4
    1.2.3. Metric Types ....................................................................................................... 5
    1.2.4. Features ................................................................................................................ 5
  1.3. USING THE GUIDE ..................................................................................................... 6
    1.3.1. Purpose ............................................................................................................... 6
    1.3.2. Topics Covered .................................................................................................... 6
    1.3.3. Related Documentation ...................................................................................... 6
  1.4. SYSTEM REQUIREMENTS ......................................................................................... 6
    1.4.1. Software Requirements ..................................................................................... 6
  1.5. LICENSING AND TECHNICAL SUPPORT ................................................................ 6

2. GETTING STARTED ......................................................................................................... 8
  2.1. INSTALLING ELECARD VIDEO QUALITY ESTIMATOR .......................................... 8
  2.2. ACTIVATING ELECARD VIDEO QUALITY ESTIMATOR ......................................... 8
  2.3. UNINSTALLING ELECARD VIDEO QUALITY ESTIMATOR ....................................... 11
  2.4. RUNNING ELECARD VIDEO QUALITY ESTIMATOR ............................................... 11

3. USING ELECARD VIDEO QUALITY ESTIMATOR ........................................................... 12
  3.1. INTRODUCTION ........................................................................................................ 12
  3.2. DESCRIBING ELECARD VIDEO QUALITY ESTIMATOR ........................................ 12
    3.2.1. ToolBars ............................................................................................................. 12
    3.2.2. Graphics panel .................................................................................................... 14
    3.2.3. Stream Panel ...................................................................................................... 15
    3.2.4. Frame Panel ........................................................................................................ 17
    3.2.5. New Task ............................................................................................................. 17
    3.2.6. Options Dialog ................................................................................................... 18
    3.2.7. Hot Keys .............................................................................................................. 22

4. COMMAND LINE TOOL .................................................................................................. 23
  4.1. CONFIGURATION FILE ............................................................................................ 23
  4.2. LIST OF COMMANDS ............................................................................................. 23
  4.3. FEATURES OF COMMAND LINE TOOL .................................................................. 25
1. Introduction

1.1. Preface

Elecard Video Quality Estimator is a powerful tool designed for professionals and prosumers in the video compression field.

Elecard Video Quality Estimator allows the user to calculate video quality metrics, such as PSNR, APSNR, SSIM, DELTA, MSE, MSAD, VQM, NQI, VMAF and VMAF phone to compare two streams with referenced RAW data, analyze differences, and identify the code portion causing the quality change.

1.2. Describing Elecard Video Quality Estimator

The following section defines the specification and features of Elecard Video Quality Estimator.

1.2.1. Supported Video Formats

- MPEG-1 Video stream,
- MPEG-2 Video stream,
- AVC/H.264 Video stream,
- HEVC/H.265 Video stream,
- VP9 Video stream,
- AV1 Video stream,
- MPEG-2 Transport Stream (MPEG-1/2, AVC, HEVC),
- MPEG-2 Program Stream (MPEG-1/2, AVC, HEVC),
- AVI file container (MPEG-1/2, AVC, HEVC),
- MP4 file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
- MKV file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
- WebM file container based on MKV (VP9, AV1),
- IVF file container (VP9, AV1),
- FLV file container (AVC).

1.2.2. Supported Raw Formats

- I444
- IYUV
- NV12
- NV21
- P444
- RGB24
- RGB32
- UYVY (Y422, UYNY, HDYC)
- V210
- V400
- Y42B
• YUY2 (YUNV, V422, YUYV)
• YV12
• YV16
• YVYU
• Y4M

1.2.3. Metric Types

• **PSNR** – Peak Signal-to-Noise Ratio.
• **APSNR** – average values of PSNR results calculated for a sequence and based on mean values of MSE results.
• **VQM** – Video Quality Measurement Techniques – a metric designed to calculate video quality and measure perceptual effect of video distortions.
• **SSIM** – Structural SIMilarity. This metric is based on measuring three components (luminance similarity, contrast similarity and structural similarity) and combining them into result value.
• **DELTA** – the value of this metric is the mean difference of the color components in the correspondent points of image.
• **MSE** – Mean-squared-error based metric.
• **MSAD** – the value of this metric is the mean absolute difference of the color components in the correspondent points of image.
• **NQI** – New Quality Index - is a metric designed to calculate video quality by combining three components: correlation loss, luminance and contrast distortion.
• **VMAF** – Video Multimethod Assessment Fusion is an objective full-reference video quality metric developed by Netflix in cooperation with the University of Southern California.
• **VMAF phone** – a metric designed to predict the quality of videos displayed on mobile phones.

**Note:** if the VMAF and VMAF phone metrics are enabled, and if input raw file is missing, encoded reference file should be placed in the input 2 (B) field.

1.2.4. Features

• Calculation of video quality metrics (PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI, VMAF and VMAF phone);
• Selection of ROI (region of interest) for metrics calculation;
• Display of essential statistics of encoded streams;
• Automatic selection of the similar first frame in two streams for analysis synchronization;
• Comparison of two encoded frames from different streams with a reference stream;
• Sharing comments between application instances and/or applications of Elecard StreamEye Studio set;
• Synchronization between applications of Elecard StreamEye Studio set (Binding mode);
• Bit distribution display;
• Command line tool;
• Saving data into CSV or text files;
• Display of comparison results in graphs: quantizer, frame size, bit allocation etc.
1.3. Using the Guide

1.3.1. Purpose

This guide is intended to help the user utilize Elecard Video Quality Estimator. It describes the Video Quality Estimator GUI, settings and functions and provides instructions for using Video Quality Estimator.

1.3.2. Topics Covered

The following lists the topics covered in this document:

- **Section 1: Introduction** – provides a general overview of Video Quality Estimator and describes the purpose of the document and its contents.
- **Section 2: Getting Started** – describes how to install, uninstall and run Video Quality Estimator.
- **Section 3: Using Elecard Video Quality Estimator** – describes the Video Quality Estimator GUI, provides instructions for comparing video streams and viewing the results of comparison.
- **Section 4: Command Line Tool** – covers advantages and features of Command Line Tool, and describes a list of commands applied for automatic analysis of media streams.

1.3.3. Related Documentation

For additional information, review the following documents:

- ISO/IEC 11172-2 for MPEG-1 video
- ISO/IEC 13818-2 for MPEG-2 video
- ISO/IEC 14496-10 for AVC/H.264 video
- ISO/IEC 23008-2 MPEG-H Part 2
- ITU-T Recommendation H.265
- A VP9 Bitstream Overview for Google VP9
- AV1 Bitstream & Decoding Process Specification

1.4. System Requirements

1.4.1. Software Requirements

- Ubuntu 16.04 LTS, x64;
- CentOS 7.6 x86_64.

1.5. Licensing and Technical Support

By installing, copying, or otherwise using the SOFTWARE PRODUCT or any UPDATES, you agree to be bound by the terms of the "Elecard" End-User License Agreement ("EULA"). This EULA is a legal agreement between you (either an individual or a single entity) and Elecard for the "Elecard" software product(s) accompanying this EULA, which include(s) computer software and may include "online" or electronic documentation, associated media, and printed materials ("SOFTWARE PRODUCT").
For technical support, please contact Elecard Technical Support Team: tsup@elecard.com
For sales and licensing information, contact Elecard Sales Department: sales@elecard.com
2. Getting Started

The following section details the procedures for installing and running Elecard Video Quality Estimator.

2.1. Installing Elecard Video Quality Estimator

Elecard Video Quality Estimator is supplied as part of Elecard StreamEye Studio or as a standalone application. The application is installed via Elecard StreamEye Studio or Elecard Video Quality Estimator installer.

Depending on the purchased product or version, the installation file is located:

- in /opt/Elecard/VideoQualityEstimator/bin folder as a separate application;
- in /opt/Elecard/Elecard StreamEye Studio/VideoQualityEstimator/bin folder as part of Elecard StreamEye Studio.

The console is located in /opt/Elecard/VideoQualityEstimator/bin folder.

To install Video Quality Estimator on Linux OS, follow the steps below:

- Install the Video Quality Estimator software by running the VideoQualityEstimator-4.x-Linux.deb file.
- Install Sentinel Runtime (Sentinel License Manager allows using the license).

2.2. Activating Elecard Video Quality Estimator

Make sure that Sentinel License Manager software has been installed on your computer. License Manager is provided within the product installation pack for Windows OS and macOS and installed automatically.

License Manager is provided as a separate installation pack for Linux OS and should be installed manually.

Please note, Linux OS reinstallation will make the activated product license invalid.

To check that License Manager is properly installed, go to Sentinel Admin Control Center at http://localhost:1947. If you see your license information, the installation is successfully completed.
License Manager allows configuring, controlling, monitoring and looking through a list of available licenses. For more details on License Manager operation click the Help tab.

Note, each page contains the Help tab related to this page only.

There are two ways to activate Elecard Video Quality Estimator: on-line and offline.

On-line activation

1. Be advised, that Internet connection is required for this type of activation.
2. Your purchase confirmation e-mail will contain a product key serial number for on-line activation. Make sure you inform your account manager that you are looking to activate the product on-line.
3. Enter the received product key XXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX in the On-line activation with a product key field, as shown below, and click Activate. Your application is successfully activated.

Offline activation

For Elecard Video Quality Estimator activation, a C2V (client-to-vendor) file should be created. To create the C2V file follow the steps:

1. Open the File tab and select Options in the drop-down menu.
2. A dialog window should open. Open the License tab.
3. Select HASP-SL for PC-based or HASP-HL for dongle-based activation in the Offline activation with license files field. Note, if you select a PC-based (HASP-SL) activation, full featured activated Elecard Video Quality Estimator will run only on this particular hardware. If
you have Elecard dongle, plug it into a free USB port on your computer and select dongle-based (HASP-HL) activation. It will be possible to use Elecard product on any hardware with the dongle plugged in.

![Offline activation with license files](image)

**Figure 3. Offline activation with license files**

4. Click the **Collect license information** button. The **Save File** dialog box should open. Click **Save** and save the C2V file to a required directory. Send the saved C2V file to Elecard Sales at sales@elecard.com.

![Creating a C2V file: License tab](image)

**Figure 4. Creating a C2V file: License tab**

5. After receiving the V2C file containing license information back from Elecard Sales save the received file to a required directory. Open the **File** tab and select **Options** in the drop-down menu again. Open the **License** tab and click **Apply license update** (see Figure 4). The file selection dialog box should appear. Choose the received V2C file and click **OK**. Your
application is successfully activated.

2.3. Uninstalling Elecard Video Quality Estimator

Elecard Video Quality Estimator can be uninstalled as part of Elecard StreamEye Studio or as a standalone application. Depending on the operating system, there are two options of uninstalling the application.

1. To delete the Elecard application from Ubuntu:
   - Enter the command in the terminal: `sudo apt remove <application>`;
   - Or using the Ubuntu Software icon:
     - When Ubuntu Software opens, click the Installed button at the top.
     - Select the application that you want to delete, click Remove and Confirm the application remove.
     - You will be asked to authenticate by entering your password. After authentication the application will be removed.

2. To delete the Elecard application from CentOS:
   - Enter the command in the terminal: `sudo yum remove <application>.

2.4. Running Elecard Video Quality Estimator

To run Elecard Video Quality Estimator, click Menu → Applications → Elecard StreamEye Studio → Elecard Video Quality Estimator.

To run Elecard Video Quality Estimator, click Menu → Applications → Elecard Video Quality Estimator.
3. Using Elecard Video Quality Estimator

3.1. Introduction

The following section describes Elecard Video Quality Estimator GUI (graphical user interface).

The Elecard Video Quality Estimator program has a simple user-friendly interface that allows the user to perform a number of operations including: opening 2 encoded streams and 1 raw stream for analysis, comparison and displaying the results of comparison along with basic parameters of the encoded streams.

3.2. Describing Elecard Video Quality Estimator

The following section describes Elecard Video Quality Estimator GUI.

3.2.1. ToolBars

The following table describes Elecard Video Quality Estimator toolbars.

Table 1. Elecard Video Quality Estimator GUI - Toolbars

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open file</td>
<td></td>
<td>Opens media for analysis.</td>
</tr>
</tbody>
</table>
Go to begin

Step backward

Play

Step forward

Go to end

Go to end - sets the current position to the last frame in the stream.

Play - starts and stops the stream playback.

Next - sets the current position to the next frame.

Previous - sets the current position to the previous frame.

Go to beginning - sets the current position to the first frame in the stream.

Region of interest (ROI) – limits analysis to the specified field: Normal / Inverse. Values of ROI: X: -1; Y: -1; W: -1; H: -1.

Output – shows and activates the current window (A / B / RAW / Difference)

Displays grid for convenience: none, 4x4, 8x8, 16x16, 32x32.

Selects color space to be displayed: YUV, Y, U, V.

Sets the video scaling coefficient: x0.25, x0.5, x1, x2, x4, x8.

The saving parameters can be also configured in the Options tab.

Open the program settings dialog. Allows setting the number of files in a list, selecting color theme, enabling the delete missing recent files automatically function, and configuring the saving parameters.

Enables or disables the Binding mode:

• Leader – allows sending comments, commands on interface or positioning changes to other applications;

• Follower – allows receiving comments, commands from other applications.

Enables/disables the comparison of Streams A and/or B with the Raw stream. The combo-boxes Difference Mode, Source 0, Source 1 are displayed. The following Difference modes are available:

• Compare – pixel-by-pixel comparison of two frames. If two pixels are matched, the result is 0. Otherwise the result is equal to the maximum value.

• Subtraction – pixel-by-pixel subtraction. The result is equal to the difference value.

• Temperature – absolute difference (pixel-by-pixel subtraction), results are highlighted (black-blue-green-red), where black corresponds to zero difference, blue corresponds to slight difference, green corresponds to medium difference and red corresponds to the biggest difference.

• PSNR – the result is the PSNR values (from 0 to 99.99) for corresponding CU partitioning blocks, where black color corresponds to 0 value, and white color corresponds to the value of 99.99 and higher.

• PSNR Clip – the same as the PSNR, but minimum result value is the minimal PSNR among all blocks in the frame and maximum – the maximal PSNR, respectively. Black color corresponds to minimal value, white color corresponds to maximal value, and blended colors correspond to intermediate values.

The following Source 0, Source 1 values are available: A, B, Raw.

Opens the recently opened files.

Closes the files.

Allows selecting parameters for saving and saves data:

• stream parameters of the whole file (metrics info, index info, stream info) in a .csv file (file stores tabular data (numbers and text) in plain text. Each line of the file is a data record. Each record consists of one or more fields, separated by commas or semicolon);

• current frame parameters (YUV data and image including A, B, RAW, Difference) as YUV or .png files.

The saving parameters can be also configured in the Options tab.
<table>
<thead>
<tr>
<th>Offset Decrement / Increment</th>
<th>Offset decrement / increment. Allows adjusting stream position relatively to others.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Allows choosing between streams: A, B, RAW.</td>
</tr>
</tbody>
</table>

**Help**

- **Feedback**: Sends the Video Quality Estimator feedback via e-mail with the following subjects: *Submit an Idea, Ask a Question, Report a Bug.*
- **About**: Shows the *About* window.

**Graphics**

- **Barchart Configuration**: Shows a stream type and frame size: None, Clustered, Overlapping, Bit Allocation, Quantizer, Graphics mode.
- **Graphics**: Displays stream graphics: A-B, A-RAW, B-RAW.
- **Metric type**: **PSNR** Visualizes all metric types selected when opening streams in the New Task window: PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI, VMAF and VMAF phone. *None* is displayed when no streams are selected.
- **Color space**: Selects color space for display: YUV, Y, U, V.
- **Horizontal range**: Adjusts graphics to the current panel size horizontally.
- **Vertical range**: Adjusts graphics to the current panel size vertically.
- **Zoom In / Out**: Scaling up and down.

### 3.2.2. Graphics panel

To open the Graphics panel, click the View tab and select Graphics. A dialog window will open.

**Graphics:**

![Graph](image_url)

*Figure 6. Elecard Video Quality Estimator GUI – Graphics*

The *Graphics panel* displays the video streams being analyzed. The bar height illustrates the frame size and the bar color indicates the frame type (red – I, blue – P, green - B). The values displayed above the graphics correspond to minimum and maximum calculated values for the selected metrics of the component(-s).

To set the stream position to a frame, click the corresponding bar.

The *Bar Chart Configuration* button – allows configuring Bar Chart presentation mode to display additional information about the streams, including: frame size and type, bit allocation and quantizer:

- **None** - is displayed when no configurations are selected.
- **Clustered** – displays chart bars by A-B pairs under the corresponding display number;
- **Overlapping** – displays overlapping (overlaid) chart bars showing variance between them;
• **Bit allocation** – number of bits that are processed per a unit of time.
• **Quantizer** – displays the frame mean Quantizer value.
• **Graphics mode** – decreases chart bar brightness to focus attention on graphics. This option is switched on by default.

To select stream graphics between A-B, A-RAW, B-RAW, click the \[ \text{_toolbar button} \] and enable checkboxes.

To see all the metric types selected for graphics displayed, click the Metric type tab \[ \text{PSNR} \]. None is displayed when no metric types are selected.

To choose the component which metrics will be displayed in graphics, click the \[ \text{button} \] and select the required streams. Click the \[ \text{or } \text{button} \] to adjust the graphics to the reference window size horizontally or vertically, the minimal size is 1 pixel per frame. Click the \[ + / - \] buttons for upscaling or downscaling the graphics.

Hover a cursor over a frame, the frame metric info is displayed.

![Figure 7. Elecard Video Quality Estimator GUI − Frame Metric Information Window](image)

### 3.2.3. Stream Panel

The **Stream** panel displays the current stream summary information: stream type, profile, compatibility flags, level, tier, chroma format, resolution, frame rate, declared bitrate, duration, epsnr, frame types, average frame size, range of quantizer values bit allocation info, frame average bit distribution in CU, prediction and transformation data.
### Stream A

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>stream type</td>
<td>HEVC/H.265</td>
</tr>
<tr>
<td>profile</td>
<td>Main</td>
</tr>
<tr>
<td>compatibility</td>
<td>Main; Main 10</td>
</tr>
<tr>
<td>level / tier</td>
<td>3.1 / Main</td>
</tr>
<tr>
<td>chroma format</td>
<td>4:2:0</td>
</tr>
<tr>
<td>resolution</td>
<td>1280 x 720</td>
</tr>
<tr>
<td>frame rate</td>
<td>25.00</td>
</tr>
<tr>
<td>declared bitrate</td>
<td>undefined</td>
</tr>
<tr>
<td>duration</td>
<td>00:00:10:000</td>
</tr>
</tbody>
</table>

### Frames

<table>
<thead>
<tr>
<th>Count</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>7 (2.80%)</td>
</tr>
<tr>
<td>P</td>
<td>52 (20.80%)</td>
</tr>
<tr>
<td>B</td>
<td>191 (76.40%)</td>
</tr>
</tbody>
</table>

### Size (byte) / enc...

<table>
<thead>
<tr>
<th>I</th>
<th>4519 / 305</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>33393 / 41</td>
</tr>
<tr>
<td>B</td>
<td>2473 / 558</td>
</tr>
</tbody>
</table>

### Bit allocation

<table>
<thead>
<tr>
<th>Max</th>
<th>1178800</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg</td>
<td>887800</td>
</tr>
<tr>
<td>Min</td>
<td>438400</td>
</tr>
</tbody>
</table>

### QP

<table>
<thead>
<tr>
<th>QP min</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>QP avg</td>
<td>30.37</td>
</tr>
<tr>
<td>QP max</td>
<td>35</td>
</tr>
</tbody>
</table>

### Distribution (bits)

<table>
<thead>
<tr>
<th>Total</th>
<th>35129 (100.00%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>split_cu_flag</td>
<td>1026 (2.92%)</td>
</tr>
<tr>
<td>cu_skip_flag</td>
<td>1065 (3.03%)</td>
</tr>
</tbody>
</table>

### Prediction

| intra_prediction | 349 (0.99%) |
| pred_mode_flag  | 142 (0.41%) |
| part_mode       | 263 (0.75%) |
| inter_prediction | 0 (0.00%) |

### Transform

<table>
<thead>
<tr>
<th>rqt_root_cbf</th>
<th>607 (1.73%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>split_transform...</td>
<td>560 (1.60%)</td>
</tr>
<tr>
<td>cbf_cb</td>
<td>666 (1.90%)</td>
</tr>
<tr>
<td>cbf_cr</td>
<td>2278 (6.49%)</td>
</tr>
<tr>
<td>cbf_luma</td>
<td>5395 (15.36%)</td>
</tr>
<tr>
<td>transform</td>
<td>22774 (64.83%)</td>
</tr>
</tbody>
</table>

---

*Figure 8. Elecard Video Quality Estimator GUI – Stream Panel*
3.2.4. Frame Panel

The **Frame panel** displays the current frame summary information: stream / display number, type, sizes, qp. If A and B streams are open, information for both streams is displayed simultaneously for better user experience in analysis and comparison. The red color corresponds to the A stream, the blue color corresponds to the B stream.

![Frame Panel Table]

### Figure 9. Elecard Video Quality Estimator GUI − Frame Panel

3.2.5. New Task

To open new media files for analysis and comparison, click the **button** or click the **File** tab and select the corresponding menu item. A dialog window will open.

Add the required streams to the **File A**, and/or **File B** and file **RAW** fields from the **Open file** dialog window by clicking the browse button or clicking the recently opened files button. Select the required parameter for the **RAW** file in a drop-down box.

Select metrics by enabling the corresponding checkboxes.

Enable checkboxes for ROI (region of interest), auto synchronization and start quality estimation after closing the dialog, if required. Specify ROI values and choose normal or inverse type of the analyzed area. Specify the frames range for auto synchronization mode.
Note: All input files should have the same resolution. If files differ in length then the shortest length is taken for calculation: metrics are not calculated for the frames beyond the shortest file length.

3.2.6. Options Dialog

To configure file settings, binding and saving modes, open the Options dialog by clicking the ◁ button or selecting the corresponding File menu command, and choose the required tab.
The following table describes the Main tab in the Options dialog.

**Table 2. Elecard Video Quality Estimator – Options dialog – Main tab**

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of recent files in list</td>
<td>Shows a number of recent files being saved in a list.</td>
</tr>
<tr>
<td>Delete missing recent files from list</td>
<td>Allows deleting missing files from the recent list automatically when opening a file from the list.</td>
</tr>
</tbody>
</table>
| Color theme                                  | Allows selecting light (default) or dark colors of the GUI background:  
- Default – light background of the GUI  
- Dark – dark background of the GUI |
| Show Task dialog when reopen                  | Allows reopening the task dialog with previously saved configurations. |
| Use the native chroma format in metric calculation | Allows specifying parser initialization buffer. |
| Open with list                               | Allows opening the file currently opened in Video Quality Estimator with another application (see details below). |
The **Options Dialog** allows opening a file with an external application. To open the file currently opened in Video Quality Estimator with another application, specify its name and path in the **Open with list** field according to parameters specified there. The parameters path and shortcut are optional. If the path parameter is not specified, default application or player supporting a file format and installed in the system is opened. Each string specified in the **Open with list** field corresponds to an individual item in the menu **File – Open with**, that allows easy switching between applications or players after configuring the field.

The following table describes the Save tab in the Options dialog.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal separator in .csv file</td>
<td>Allows selecting decimal comma or decimal dot to separate an integer part from a</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data delimiter in .csv file</td>
<td>Allows selecting comma or semicolon to specify boundaries in data stream.</td>
</tr>
<tr>
<td>Add distribution info to</td>
<td>Allows adding distribution info when saving a file: Stream info, Picture info, Index info.</td>
</tr>
<tr>
<td>Add metric info to Index file for</td>
<td>Allows adding metric info for the selected parameters when saving: Y component, U component, V component.</td>
</tr>
<tr>
<td>Save YUV data in wide format</td>
<td>Allows saving YUV data as planar 4:4:4 2byte per component regardless of input format.</td>
</tr>
</tbody>
</table>

To configure the **Binding mode** settings, open the corresponding tab. The **Binding mode** allows exchanging information between applications contained in Elecard StreamEye Studio, selecting applications from which messages should be received, type of the messages to be received, synchronizing application window size and switching between controls.
3.2.7. Hot Keys

For tabs, functions and modes switching press hot keys described hereto.

- Ctrl + O – opens a media file.
- Ctrl + R – opens the recently opened file.

The following hot key combinations are used for Navigation:

- Ctrl + Shift + Left – starts the Go to beginning function.
- Alt + Left – goes to the Previous frame.
- Ctrl + Space – starts and stops the Play function.
- Alt + Right – goes to the Next frame.
- Ctrl + Shift + Right – starts the Go to end function.

To change View configuration of panel controls, use the following hot keys:

- F2 – shows / hides all controls.
- F3 – shows all (controls).

For configuring information panels, use the following hot key combinations:

- ALT+1 – shows / activates the stream A panel.
- ALT+2 – shows / activates the stream B panel.
- ALT+3 – shows / activates the frame panel.

The following hot keys are used for switching Output Panels:

- CTRL+1 – activates the A panel.
- CTRL+2 – activates the B panel.
- CTRL+3 – activates the RAW panel.
- CTRL+4 – activates the Difference panel.
4. Command line tool

Elecard Video Quality Estimator Command Line tool is designed for insight into MPEG-2, H.264/AVC, H.265/HEVC, VP9 and AV1 video compression standards and ever fast quality and compliance check.

Video Quality Estimator Command Line tool allows automatic analysis of video arrays. You can customize a sequence of commands to perform your specific tasks and automate your routine tasks.

Get to the command prompt by clicking Start->Run and type 'cmd'. Then enter the command to start the application first and proceed with the command line options. In general, the syntax is as follows:

```
./videoquest-cli config.xml /inA:input.avc /out:output_avc /ref:ref_input.yuv
```

*Note: You should not relocate the <product> console without all the other applications of the product contained in the installation pack, otherwise the console application will not start.*

4.1. Configuration File

**Configuration file** – contains all the commands performed by the application and reflects overall operation results:

```
<xml version="1.0"?>
<VQ version="1">
  <input1 file="..." stream="-1(default)" offset="0(default)"/>
  <input2 file="..." stream="-1(default)" offset="0(default)"/>
  <reference file="" type="YV12(default)" step="1(default)"/>
  <output separator="/" delimiter="," file=""/>
  <roi x="0" y="0" width="0" height="0" inverse="true" false"/>
  <sync window="0(default)">
    <range span="all(default)" start - stop/>
  </sync>
  <info>
    <stream distribution="on(default)" off file=""/>
    <index distribution="on(default)" off file=""/>
    <metrics data="All(default) | AB | ARaw | ..." type="PSNR(default) | SSIM | ..." file=""/>
    <data source="A/B/AB" format="yuv(default) file=""/>
    <difference type="compare/subtraction/temperature/psnr/psnr clip" source="AB file=""/>
  </info>
</VQ>
```

*Figure 14. Elecard Video Quality Estimator GUI – Configuration File Structure*

4.2. List of Commands

**List of commands** contains information on the commands and all parameters, which may be used within a command, and their description.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;input1/&gt;</td>
<td>The tag is used to configure the input file;</td>
</tr>
<tr>
<td>&lt;input2/&gt;</td>
<td></td>
</tr>
<tr>
<td>stream offset</td>
<td>Specifies the elementary video stream number, if number of streams exceeds one. «1» — first available elementary video stream. It is set by default. Starting frame for further calculation. Offset from the beginning up to the specified frame in the stream. It is expressed in frames.</td>
</tr>
<tr>
<td>&lt;reference/&gt; type file offset step</td>
<td>The tag is used to configure the reference file; Defines the format of the raw data. (YV12 (is set by default) / IYUV are used now. More formats to be supported in the next updates.); Sets the path to the reference file. Offset from the beginning up to the specified frame in a reference stream. It is expressed in frames. “0” is set by default. Coefficient used for calculation of a successive frame number for further analysis. “1” is set by default.</td>
</tr>
<tr>
<td>&lt;output/&gt; separator delimiter file</td>
<td>The tag is used to configure the output file; Allows selecting decimal comma or decimal dot to separate an integer part from a fractional one of a real number. Allows selecting comma or semicolon to specify boundaries in data stream. Sets the output file path.</td>
</tr>
<tr>
<td>&lt;roi/&gt; normal inverse</td>
<td>Region of interest selected for measurement; Measures the specified field of the frame; Measures the whole frame field except the specified part</td>
</tr>
<tr>
<td>&lt;sync/&gt;</td>
<td>Specifies the frames range for auto synchronization mode. “0” is set by default.</td>
</tr>
<tr>
<td>&lt;range/&gt; span</td>
<td>The tag is used to define the range of analyzed frames; Defines the range of frames (all (by default) /start - stop), ‘start’ - number of the first analyzed frame, ‘stop’ - number of the last analyzed frame.</td>
</tr>
<tr>
<td>&lt;stream/&gt; distribution file</td>
<td>The tag is used to output general information about the analyzed stream; Contains information on data distribution by type of coding units (on (by default) / off); Sets the output file path where information on frames will be saved.</td>
</tr>
<tr>
<td>&lt;index/&gt; distribution file</td>
<td>The tag is used to output information about frames (offset, frame type, frame size, average quantizer, etc.): Contains information on data distribution by type of coding units (on (by default) / off); Sets the output file path where information on frames will be saved.</td>
</tr>
<tr>
<td>&lt;metrics/&gt; data type file</td>
<td>The tag is used to output information on quality metrics; Specifies the type of the streams selected for metrics calculation and saving: All (by default)</td>
</tr>
<tr>
<td>&lt;data/&gt; source format file</td>
<td>The tag is used to save output decoder information on any decoding step; Defines the type of the source for metrics calculation: A</td>
</tr>
<tr>
<td>&lt;difference/&gt; type source file</td>
<td>The tag is used to output information on difference metrics Defines the type of difference (compare/subtraction/temperature/psnr/psnr clip). This is the required parameter for this tag. Its default value should be set. If the value is not set, this tag will be skipped; Specifies the source type for difference calculation: AB</td>
</tr>
</tbody>
</table>
4.3. Features of Command Line Tool

- Analysis the whole array of video files automatically;
- Addressing specific and complex challenges with a few lines of commands;
- Retrieving submitted results as a text file in CSV format for easy viewing in Excel;
- Customizing a sequence of commands to perform your specific tasks;
- Accelerating and automating your regular tasks.